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Overview 
 

OLI Systems, Inc. has been providing software for the chemical industries since 1971. 

During that time, technical support has been a primary focus. To help facilitate the user 

interacting with OLI’s technical support document, there are some things that the user 

should know. 

 

There are many tools to interact with Tech Support. These tools are: 

 

 Live phone support 

 E-mail support 

 Web based support 

 Web based knowledge base 

 Web based live training & support 

 

 

The Right Chemistry 
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 Off-line web based training 

 FTP Site to upload and download files 

 

Before contacting Tech Support, the user should be prepared to send the files that are 

causing the problems. These files are different depending on the program being 

considered. Sending the files may also cause some virus protection programs to strip the 

files from E-mail. 

 

OLI File Structures 
 

OLI Analyzers 
 

The files used by the OLI Analyzers are binary files. Some of these files may cause a 

virus protection alert when being E-mailed to OLI. This situation will be discussed later 

in this document. 

 

Table 1 Analyzer File Extensions version 3.0 and later 

Program File Extension 

OLI Studio (contains Stream, Corrosion and EVS) .oad 

 

 

For versions before 3.0 there are four (4) Analyzer programs. Each has its own file 

extension. You will need to turn on File Extensions in Windows. See the Appendix on 

how to turn on the extensions. 

 

Table 2 Analyzer File Extensions version 2.0 and earlier 

Program File Extension 

Stream Analyzer .sta 

Corrosion Analyzer .cra 

Lab Analyzer .laa 

Score Analyzer .sco 

 
ScaleChem 
 

ScaleChem has several files that are of importance. One of the files is a binary file (SCA) 

and is most commonly sent for technical support. Other files are text files and they may 

be required occasionally. 

 

Table 3 ScaleChem Files 

Extension Type Description 

.sca Binary Primary ScaleChem file 

.osc Text Primary output file 

.sin Text Input file to solver.  

.dat Text Brine data input to solver 
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ESP 
 

ESP creates two classes of files. The first set is for the chemistry model. The second set is 

for the process model. All files are text 

 

Table 4 Chemistry Model files 

Extension Class Description 

.mdl User input Model definition file. This 

file contains the user’s input 

chemistry 

.mod Generated/modifiable This is a text version of the 

chemistry model. It can be 

modified by the user 

.dbs Generated/non-modifiable This is the numeric version 

of the database. It can not 

be modified by the user. 

 

 

Table 5 Process Model files 

Extension Class Description 

.bin User Input This is the process input 

file. 

.bst Output This is the stream output 

file. This file generates the 

stream listings 

.bre Output This is the block report file. 

The block reports come 

from this file. Also, this file 

is used to Restart multistage 

unit operations 

.bou Output This is the block output file. 

The process trace listing 

(the order of blocks) is 

found in this file. All the 

stream and block 

information is stored in this 

file. Rarely sent to OLI 

.TEA Output Tear Stream restart file. 

This is available only in 

ESP v7.0.30 or later. Rarely 

sent to OLI 
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OLI Databook Structure 
 

The OLI Databooks are a series of 39 files for each databook. The first three characters of 

a databook must be unique in a folder and must not be the same as any database stored in 

the following folder: 

 

C:\ProgramData\OLI Systems\Databanks\X.Y.Z 

 

Assuming that the default installation folder is c:\ProgramData and X.Y.Z is the current 

version number (for example 9.2.6) 

 

As an example, we will look at the structure of an OLI database NASALTS 

 

NASALTS is a collection of 39 files.  

 

Table 6 OLI Database Structure 
File Type File Type 

NASVP.RAW Vapor pressure raw data NASALTS.SYN Species Synonyms 
NASSYN.NDX Index to synonyms NASALTS.STR Species Structure 

NASSTRU.NDX Index to structures NASALTS.SOU Species solubility data 
NASSOU.NDX Index to solubility data NASALTS.SOR Species source data 
NASSOR.NDX Index to sources NASALTS.REF Reference data 

NASSOLU.RAW Solubility raw data NASALTS.REC Database record structure 
NASREF.NDX Index into references NASALTS.RDX Redox data 

NASMATS.NDX Index to material code symbols NASALTS.NDX Index of allspecies 
NASMATN.NDX Index to material code numbers NASALTS.MAT Material codes 
NASMATC.NDX Index to material code charges NASALTS.ION Ion Codes 

NASLID.NDX Index to lattice identification NASALTS.INT Species interaction data 
NASIONS.NDX Index to ion code symbols NASALTS.EQS Equation types 
NASIONN.NDX Index to ion code numbers NASALTS.DOC Reference data 
NASACTI.NDX Index to activity interactions NASALTS.DIC Database structure file 

NASFORM.NDX Index to formulas NASALTS.DDB Pure component data 
NASEQS.NDX Index to equations NASALTS.COP Coprecipitation data 

NASDENS.RAW Density raw data NASALTS.CND Electrical Conductivity data 
NASDENS.NDX Index to density data NASACTI.RAW Interaction raw data 

NASCP.RAW Heat Capacity raw data NASINT.NDX Index of interactions. 
NASCAS.NDX Index to CAS numbers   

 

 

As you can see, some files are named NASALTS (e.g., NASALTS.DIC) but others are 

named with only the first three letters – NAS (e.g., NASREF.NDX). This is important if 

you send the files to OLI for analysis. 

 

To send the files to OLI, you first need to search for all the files. Using NASALTS as a 

reference, the search would be 

 

NAS*.* 

 

This may return more than 39 files. This is allowable, please place all the files into an 

archive such as WinZip and send them to OLI. 
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Aspen HYSYS 
 

Aspen HYSYS files have an .hsc file extension. This file should be sent to OLI. If you 

have a private databank, this also needs to be sent to OLI, see OLI Databank Structure 

above. 

 

Aspen PLUS 
 

Table 7 File types required by OLI 

File Type File Extension 

OLI Chemistry model (Wizard) .cwa 

OLI Chemistry model (standard) .mdl and .mod 

OLI Generated Chemistry .dbs 

Aspen Backup file (flowsheet) .bkp 

Aspen Plus flowsheet .apw or .apwz 

Note: you need only send either the Wizard files or the Standard files, not both. 

 

If you have a private databank, this also needs to be sent to OLI, see OLI Databank 

Structure above. 

 

Unisim Design 
 

Unisim Design files have an .usc file extension. This file should be sent to OLI. If you 

have a private databank, this also needs to be sent to OLI, see OLI Databank Structure 

above. 

 

Chemistry Wizard (Non-Aspen PLUS) 
 

Table 8 Stand-alone Chemistry Wizard files 

File Type File Extension 

OLI Chemistry model  .cws 

OLI Generated Chemistry .dbs 

 

If you have a private databank, this also needs to be sent to OLI, see OLI Databank 

Structure above. 

 

File Uploads 
 
With recent increases in security, sometimes it is impossible to send the required files to 

OLI. If this happens please use the following web site: 

http://support.olisystems.com/upload.aspx 

http://support.olisystems.com/upload.aspx
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Live Phone Support 

 

OLI Systems, Inc. is located in Northern New Jersey, United States. Our office hours are 

8:30 AM to 5:00 PM Eastern Time (New York). 

 

Our phone numbers are: 

 

Support:  973-539-4996 extension 24 (USA) 

Fax:   973-539-5922 (USA) 

 

 

E-mail Support: 
 

You can contact OLI via E-mail for a variety of reasons.  The Emails are on the main 

OLI website www.olisystems.com and on the support website support.olisystems.com 

 

 

 

Web Based Live Training and Support 
 

OLI Systems has partnered with AQSim to use WebEx facility to conduct live training.  

To use Webex, you will need to check to see if you can support the plug-in for Internet 

explorer. 

 

 

Occasionally you will need to use OLI’s teleconferencing facility. OLI will supply the 

phone numbers as required.  

 
Using the Contact Support button 
 
Starting with OLI Security 3.2.6 and OLI Products 9.2.6 you can now send the state of 

the OLI software on your computer directly to OLI. This is now accomplished via a new 

button on the OLI Help>About dialog or from various error dialogs.  

 

Although the data is collected automatically, you will still be in control of actually 

sending the data to OLI. OLI would never send data about your computer without your 

permission. The data is either sent first by Email or then by an FTP-like protocol to the 

OLI servers. The data is sent confidentially. 

 

Here is the location of the new button on the Help>About dialog: 

http://www.olisystems.com/
http://support.olisystems.com/
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Clicking the Contact Support button will give you a new dialog: 

 

Please enter the text fields. A comment as to what you were doing is also helpful. 
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What about privacy? What information is sent to OLI with this function? 
 
Using the information in the image above, the following was sent to OLI. 
 

General Information 
Company: OLI Systems. User: James Berthold Email: james.berthold@olisystems.com Phone: Comments: Test 

Security Information 
This is data primarily about the products enabled by the stand-alone or client serial numbers. The example below is for a network version. The stand-alone or client serial number is displayed. 

[Security Info] SerialNumber 

V2-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX 

No Expiration Date 

Network License Server Client 

Protection Key: HASP SL, ID = LS5400002 

\DatabankPublicStandard 

\DatabankPublicExtended 

\FullAccess 

\DatabankMSEPubStandard 

\CorrosionRates 

\ReferenceStateProperties 

OLIEngine 

OLIEngine\AllianceEngineDeveloper 

OLIEngine\Generic 

OLIEngine\Toolkit 

ESP 

CSP 

ScaleChem 

StreamAnalyzer 

StreamAnalyzer\Tester 

CorrosionAnalyzer 

CorrosionAnalyzer\Automation 

SCOREAnalyzer 

SCOREAnalyzer\SCORETemplateCreation 

StudioScaleChem 

StudioPIPESIM 

CCModeler 

OLIBridge 

OLIHighTemp 

EVSAnalyzer 

Network Information 
This information is about the network connections if you have this version. Stand-alone versions will not display this information. The server serial number will be displayed. 

Network Security Server Binding 

'ncacn_ip_tcp:granite[12345]' 

Network Security Information 

Expiration Date = 12/31/2015 

Serial Number = V2-YYYY-YYYY-YYYY-YYYY-YYYY-YYYY 

Hardlock ID = LS5400002 

License Usage 
If permitted by your administrator, the license count for the products is also displayed. 

Products Max Used Avail 

CorrosionAnalyzer 25 2 23 

ESP 25 0 25 

EVSAnalyzer 25 2 23 

OLIEngine 25 2 23 

ScaleChem 25 0 25 

StreamAnalyzer 25 2 23 

 

Operating System Information 
We will collect information about your operating system. 

[System Info] Windows 7 Professional (6.1.7601) Service Pack 1 

System type: 64-bit Operating System 

Available Memory 2475796 KB 

Total Memory 4194303 KB 

Swap File Used 0 KB 

Swap File Max. 4194303 KB 
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OLI Plug-ins Installed 
OLI uses some plug-ins (which OLI authored) and they are listed next. 

[Program Options] OLI Studio Plug-Ins 

Name: Stream Analyzer (Installed) 

Path: C:\Program Files (x86)\OLI Systems\OLI Studio 9.2\Studio\StreamAnalyzer.olx 

Version: Build 9.2.4 

 

Name: Corrosion Analyzer (Installed) 

Path: C:\Program Files (x86)\OLI Systems\OLI Studio 9.2\Studio\CorrosionAnalyzer.olx 

Version: Build 9.2.4 

 

Name: EVS Analyzer (Installed) 

Path: C:\Program Files (x86)\OLI Systems\OLI Studio 9.2\Studio\EVSAnalyzer.olx 

Version: Build 9.2.4 

 

Name: Studio ScaleChem (Installed) 

Path: C:\Program Files (x86)\OLI Systems\OLI Studio 9.2\Studio\StudioScaleChem.olx 

Version: Build 9.2.4 

 

Name: OLI File Viewer (Installed) 

Path: C:\Program Files (x86)\OLI Systems\OLI Studio 9.2\Studio\DbsFileViewer.olx 

Version: Build 9.2.4 

 

Program Load Log 
We will copy the information you see on the OLI Splash Screen. 

[Log] Loading 'OLIEngine'. 

Loading 'StreamAnalyzer'. 

Loading 'CorrosionAnalyzer'. 

Loading 'EVSAnalyzer'. 

Loading 'StudioScaleChem'. 

Loading 'StudioPIPESIM'. 

 

DLL Loads 
The DLL files that OLI loads is also captured. Most of these files are authored by OLI Systems but a few are part of the operating system. The version number of the DLL is also captured. The following is only a partial 

list of what we collect. 

ExePath=C:\Program Files (x86)\OLI Systems\OLI Studio 9.2\Studio\OLIStudio.exe 

RegistryKeyName=OLI Studio 9.2 

ProductName=OLI Studio 

SerialNumber=V2-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX 

SerialData= 

SecurityOptionToCheck= 

VersionMajor=9 

VersionMinor=2 

VersionRevision=4 

VersionBuild=0 

HasDocumentsDirectory=true 

DocumentsDirectoryPath= 

HasSamplesDirectory=true 

SamplesDirectoryPath= 

RegUseSecurityKey=true 

AllowAutoLogin=true 

CommonFilesPath='C:\Program Files (x86)\Common Files\OLI Systems\' 

Files in - 'C:\Program Files (x86)\Common Files\OLI Systems\' 

OLIClientSecurityProvider.dll - [3.2.5] OLISecurity 
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OLIHtmlHelp.dll - [1.0.3] OLI HTML Help Support Library 

OLIProcessSecurityProvider.dll - [3.2.5] OLISecurity 

OLIProcessSecurityV1.dll - [2.1.14] OLISecurity 

 

Registry Entries 
The OLI related registry entries from both current user and local machine are captured. This example is only a partial list: 

[HKEY_LOCAL_MACHINE\Software\OLI Systems\Analyzer 2.0\Common\Application] 

"TemplatesDirectory"="C:\\Program Files (x86)\\OLI Systems\\Analyzer 2.0\\Templates" 

"SerialNumber"="V2-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX" 

"SamplesDirectory"="C:\\Program Files (x86)\\OLI Systems\\Analyzer 2.0\\Samples" 

"SerialNumberTimeStamp"="10-1-2014 11:04:48" 

"SerialData"="" 

 

 

Appendix 
 

How to turn on file extensions in Windows 2000 and XP? 
 

From  My Computer select Tools and then Folder Options. Click on the View tab. 

Uncheck the Hide extensions for known file types. 

 

 
Figure 1 

Click the Apply button and then OK. 

Uncheck 

this box 


